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GUI and Symbol Conventions

[] Represents a function module or menu, such as: in the [ Status] menu.
- Multi-level menus are separated by the ">" signs. For example, choose File > Create >
Folder.
. Please be careful of the contens under Cautions, improper action may result in loss of
Cautions .
data or device damage.
Note Note contain detailed descriptions and helpful suggestions.

Technical Support

Email: support@inhandnetworks.com

URL: www.inhandnetworks.com
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1 Overview

Edge Router 605 (ER605 for short) is a next-generation edge router developed by InHand to provide fast
and secure network connections for business applications. Leveraging 4G cellular networks and various
broadband services, ER605 provides ubiquitous, uninterrupted access to the Internet for a variety of business
devices. With comprehensive security and wireless features, it establishes real high-speed channels for data
transfer between devices.
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Figure 1 ER605 application
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2 Hardware

2.1 Indicator Description

LED Indicator

Status and Description

System status
indicator

Off — The router is off.

Solid red — The system is starting.

Blinking — The system is running properly.
Blinking red — The system does not work properly.
Blinking — The system is upgrading.

Connectivity status
indicator

Off — The router is not connected to network.

Blinking red — The router is connecting to the cellular network.

Solid green — The router has connected to the cellular network successfully.
Blinking blue — The router is connecting to the wired network.

Solid blue — The router has connected to the wired network successfully.

Cellular signal

Off — No signal.
Solid red — Signal strength is poor.

indicator Solid — Signal strength is good.
Solid green — Signal strength is excellent.
Off: The Wi-Fi 2.4 GHz band is off.

Wi-Fi 2.4G Solid — The Wi-Fi 2.4 GHz does not work properly.
Blinking — The Wi-Fi 2.4 GHz band is working properly.
Off: The Wi-Fi 5 GHz band is off.

Wi-Fi 5G Solid green — The Wi-Fi 5 GHz does not work properly.

Blinking green — The Wi-Fi 5 GHz band is working properly.

Note: If both the cellular and wired networks are connected, the connectivity status indicator shows yellow
(wired network). If one of networks is not connected, the indicator shows the color corresponding to the
connected network. If neither network is connected, the indicator shows red.
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2.2 Using the Reset Button to Restore Factory
Settings

DC 9-38V

Procedure:

Step 1: Power on the device (10 seconds), press and hold the reset button until the SYS indicator is steady
yellow

Step 2: Release the button, wait for the SYS LED to flash yellow.
Step 3: Press the reset button again until the SYS indicator is steady yellow
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Default Settings

No. Function Default Settings
1 Cellular network | — Both SIM cards are enabled, and SIM1 is used preferentially.
dial-up
— The Wi-Fi 2.4 GHz access point (AP) is enabled, and its SSID is
ER605— followed by the last six digits of the wireless MAC address.
- The Wi-Fi 5 GHz AP is enabled, and its SSID is ER605-5G—
2 Wi-Fi followed by the last six digits of the wireless MAC address.
—  The authentication method is WPA2-PSK.
— The two access points have the same password: last eight digits of the
router's SN.
—  Four LAN interfaces are enabled.
—  The IP address is 192.168.2.1.
3 Ethernet -~ The subnet mask is 255.255.255.0.
— The DHCP server is enabled to allocate IP addresses to connected
devices from the address pool 192.168.2.2-192.168.2.100.
4 Network access — Local HTTP and HTTPS services are enabled, using ports 443
control —  Access from the cellular network is disabled.
User name and — The user name is adm (super administrator), and the password is
5
password 123456.
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4 Quick Network Connection

4.1 Environment Setup

Step 1: Install the 4G and Wi-Fi antennas, and insert SIM cards into the router.
Step 2: Connect the power cable and Ethernet cable, and connect any of LAN interfaces to a PC.
Step 3: Assign an [P address to the PC, which must be in the same network segment as the router.

As the dhep server function is enabled by default on the LAN interface, the PC must be in the same network
segment as the router. On the PC, set IP address to any value in the range of 192.168.2.2-192.168.2.254,
Default gateway to 192.168.2.1, Subnet mask to 255.255.255.0, Preferred dns server to 8.8.8.8, and
Alternate dns server to the IP address of the carrier's dns server.

Internet Protocol Version 4 (TCP/IPwd) Properties b4 Internet Protocol Version 4 (TCP/IPwd) Properties e
General | Genaral |
|
You can get P settings assignad automatically if your network Yo €an get 1P settings assigned sutomatically f your network
SUPParts this capability. Otherwise, you need to ask your network Supports thes capabilty. Dtherwise, you need To ask your netwaork
administrater for the appropriate 1P settings. administrator for the appropriate TP settings.
(@) Obtain an IP address automatically () Obtain an IF address automatically
ise the following IF address: (@) Use the folloving [F address;
I address: 192 168, 2 . 2
Suibirust rask Subnat mask: 255 .255.255. O
Drefault gatawery . . . Default gateway: vz.168 . 2 . 1

(@) Obtain DKS server address sutomatically

Vs the following DNS sesver addneases (i Lise the following DNS server addresses
Preferrad DNS server v i : Preferred DNS server: 4 .8 .8 .8
Afomate DHE server; " X ¥ Alternate DMS server;
[Ivalidate settings upon exit PR [ validate settings upon exit Advonod

Figure 4-1-1 Dynamic/Manual IP address configuration on the PC

Step 4: Start the web browser and enter the router's default IP address 192.168.2.1 in the address box. On the
login page that appears, enter the user name and password (adm/123456 by default) to log in to the
web-based management system of the router. If the web browser displays a message, indicating that the
website is not secure, unfold the hidden or advanced settings and choose to continue.
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Figure 4-1-2 Login to the web-based management system

4.2 Internet Connection

The ER605 can connect to the Internet via three types of interfaces, each allowing for multiple connection
methods. The router has two default uplink interfaces WAN1 and Cellular, which cannot be removed. It
supports a maximum of four uplink interfaces, namely, WAN1, WAN?2, Cellular, and Wi-Fi(STA). WAN2
and Wi-Fi(STA) need to be added manually and can be removed.

42.1 Wired Connection Via a WAN Interface

The ER605 can establish a wired connection through DHCP, a static IP address, or PPPoE. To select a
connection method, click [ Internet ] on the left pane, and then click Edit in the row of WANI1

2%, ER6OS # InCloud Manager @ Internet

Device Information

B status
ame: ERG0S 2 Model: ER60S-NRQ2-WLAN Seria Firmware Version: V203

& Intemet

AC 00:18:05:00:02104 ss: WANT Uplink [P+ 10,5.47.158

& Local Network

1P: 192.168:66.10
= Wi

¢ VPN Interface Status

© secuity

© senies |

© system Cellular WANT AN 2 LaN2 LAN3 LaNg

Traffic Statistics

Cellular(siM1)

Figure 4-2-1-a Editing interface WAN1

e DHCP: The DHCP service is enabled on the WAN interface by default. Therefore, the router can
connect to the Internet immediately when the WAN interface is connected to the Internet with an
Ethernet cable.

e Static IP address: Manually assign an IP address obtained from the carrier or upstream network device.
Then, the router can connect to the Internet using this static IP address.
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Edit WANT X

Mame: WAN1

status: @D

NAT:

Type: ‘ Static IP W

* [P Address:

* Mask:

* Gateway Address:
* Main DNS:
Secondary DNS:

*MTU: | 1500

Cancel Save

Figure 4-2-1-b Assigning a static IP address to the router

¢ PPPoE: Configure the PPPoE service on WAN1. Then, the router can dial up to the Internet through the broadband
service.

Edit WAN1 X

Mame: WAN1

Status: D
NAT:

Type: ‘ PPPoE A%

* User Name:
* Password : LCH
Local IP Address:

Remote P Address:

Cancel Save

Figure 4-2-1-c Configuring PPPoE
7
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To use the second WAN interface, click Add on the [ Internet] page to add WAN2. This interface provides the same
functions as WANI.

Add Internet

name] @ wane] O wirisTy
st @

NaT:

Type: ‘ DHCP v

*MTU: | 1500

Figure 4-2-1-d Adding WAN2
Notes:
*  After you add WAN2, interface LAN1 changes to WAN2.
e After you remove WAN?2, the interface changes back to LANI.

When WAN?2 is removed, all configuration on this interface, including the static routes, inbound and
outbound rules, port forwarding, policy-based routing, VPN, and traffic shaping, is deleted.

4.2.2 Wireless Connection via the Cellular Interface

Generally, the ER605 dials up to the cellular network automatically after you install the SIM cards and
antennas according to the installation guide, and power on the router. To set the access point name (APN),

click [ Imternet ] on the left pane, and then click Edit in the row of Cellular.

% ERBOS InCloud Manager Intemet adm v %
8 tashhoarc, Uplink Table
B status ‘ + add
& intemnet S .
Priority Name Status Interface Type Type Actions.
@ Local Network P
= WANT Enable WAN DHCP 2 Edit
- WiH
= Cellular Enable Cellular: SIM1 Dialup @ rolicy
% veN
iy Note: Modifying the configuration of the intermet interface or adjusting the priority may cause the device network to be interrupted!
ecuri
® Seniices
Uplink Setting
© system
Link Detection: [ o)
Test Connectivity to: [
Enabled Last Time Detection Item Constraint Value
O 5 min Latency is less than 200 ms
O 5 min Jitter is less than 200 ms.
O 5 min Loss is less than 5%
O 5 min signal Strength is greater than Poor
(@) Link Backup
Failover Mode: Immediately Switch v
) Load balancing



[0 -

Edit Cellular
status: @D
NAT:
Work Mode: | Only SIM1
Dialing Parameters: | Auto
Service Type: | Auto
5G Type: | SA/MNSA
PIN Code:
*MTU: | 1500
Mask:

Cancel
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Figure 4-2-2-a/b Editing the cellular interface

The ER605 allows you to set traffic policies for cellular network access. After a traffic policy is enabled, the working
SIM card will take the specified action when the traffic usage reaches the set threshold.

Edit SIM Card Policy

SIM1 Threshold: (i
* Threshold: | 1
Monthly Reset Day: | 1
Action: | Noti

Usage of the month: 0 KB

SIM2 Threshold: (B
* Threshold: | 1
Maonthly Reset Day: | 1
Action: | Noti

Usage of the menth: 0 KB

fication

Modify

fication

Modify

GB

GB

AV

Cancel

Figure 4-2-2-c Configuring a traffic policy for cellular network access

Actions:

e Notification:record the generated traffic reaching the threshold event, and the traffic transmission is not restricted.

9
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e  Only Cloud Management:record the generated traffic reaching the threshold event, only keep the traffic of the
cloud management device, and the access to the Internet traffic will be restricted.

e  Switch SIM:record the generated traffic reaching the threshold event and trigger SIM card switching.

Notes:

e When the router is used on a private network, disable link detection on the [ Internet ] page. Otherwise, the
cellular interface cannot work properly, because the cellular link cannot be detected.

* Insome cases, you need to enter the subnet mask of the cellular interface to ensure proper functioning of ARP.

¢  Before removing or installing a SIM card, unplug the power cable of the router to prevent data loss or damage to
the router.

4.2.3 Wireless Connection via Wi-Fi(STA)

The ER605 can connect to an AP as a wireless client (STA). To use this connection method, click Add on
the [ Internet ] page, select Wi-Fi(STA) in the dialog box that appears, and enter the SSID and password.

Add Internet X

MNote: When the Wi-Fi (STA) interface is added, SSID(s)
with the same band will be disabled

Name: () WAN2 (@) wi-Fi(STA)

status: @D
—

NAT:
Band: (@ 2.4GHz 5GHz
* 55ID:

Security: | WPAZ2-PSK v
Encryption: | CCMP W
* Password: &

Type: | DHCP v
* MTU: | 1500

Figure 4-2-3 Adding the Wi-Fi(STA) interface
Notes:

e After you add the Wi-Fi(STA) interface, the SSIDs of the router on the same frequency band are disabled and
cannot be enabled manually.

e After you delete the Wi-Fi(STA) interface, the SSIDs on the same frequency band can be enabled or disabled
manually.

10
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. When the Wi-Fi(STA) interface is deleted, all configuration on this interface, including the static routes, inbound
and outbound rules, port forwarding, policy-based routing, and traffic shaping, is deleted.

11



N
inhand

5 Dashboard

InHand ER605 User Manual @
Click [ Dashboard ] on the left pane to display the dashboard of the router, on which you can view basic
device information, interface status, traffic statistics, cellular signals, and number of Wi-Fi connections.
;;";:, ERB05 & InCloud Manager @ Intemet
W Daeem! Device Information
B Status
ame: ER605 £ Model: ER605-NRQ2-WLAN erial
Eq s AC: 00:18:05:00:02:04 ot 6 days 23 hours 46
B {EoclNevolk oca P 192.168.66.10 Systam Time: 2022-12-26 15:24:25 UTC +0800
% VPN Interface Status
©® Security
W Services
8 system

sion: V2,03
Uplink P
Traffic Statistics

Callular

WANT

10547158

LANT

LANZ LANZ LANS
M Connected Disconnected Abnormal Disabled
WAN1 [ 39720 M8

Wi-Fi Connections

\
5.1

Clients Traffic Tops
@ =050

Figure 5 Dashboard

Device Information

Device Information

and uplink interface address vary depending on the working uplink.

192.168.66.10

Modal: ER605-NRQ2-WLAN

6 days 23 hours 46 ...

Basic information about the router is displayed on the top of the dashboard. The network connection method

e: 2022-12-26 15:24:40 UTC +08:00

Firmware Version: V2.0.3

Figure 5-1 Device information
5.2 Interface Status

nk IP: 10.5.47.158

detailed information about the interface.

The status of each interface is displayed clearly on the dashboard. You can click any interface icon to view

12
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X Interface Status
Cellular
WAN1

status:
Work Mode:

Type:

1P Address:

Gateway Address:
Lease Acquisition Time:
Lease Timeout:

Primary DNS:
Secondary DNS:

Test Connectivity to:

Figure 5-2 Interface status

5.3 Traffic Statistics

>
v

Connected

Active

DHCP
10.5.47.158/24
105.47.254
2022-12-26 152157
2022-12-27 152157
61.139.269
183.221253.100

61139.269
>
>

>

>

You can check traffic statistics collected on each uplink interface since the router is powered on. Traffic
statistics are reset after a reboot of the router. To view historical traffic statistics, log in to InCloud Manager

and enter the details page of the router.

Traffic Statistics

WAN1 17568

Wi-Fi(STA) Wl 1078 MB

Figure 5-3 Traffic statistics

5.4 Number of Wi-F1 Connections

You can view the number of SSIDs enabled on the ER605 and number of clients connected to each SSID.

Wi-Fi Connections

@ ERE05-000206
@ ER605-5G-D00207

Figure 5-4 Number of Wi-Fi connections

13
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5.5 Top 5 Clients by Traffic

You can view the rankings of clients connected to the router by their traffic statistics. A maximum of five
records can be displayed. When a client is disconnected from the router, its traffic statistics are cleared.

Clients Traffic Top5
- _____________________________________________________________________________[ENEj
DESKTOP-B... I /9375 ME
chengdou-... I 221.58 MB
AER1650-163 || 2563 MB

Figure 5-5 Top 5 clients by traffic

14
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Click Status on the left pane to display the [ Status] page, where you can view information about uplinks,
cellular signals, clients, VPNs, events, and logs of the router.

6.1 Link Monitor

The [ Link Monitor ] module displays the health of each uplink, as well as the throughput, delay, packet

loss rate, and signal strength on each uplink interface.

2%, ERBOS

& Dashboard

& inCloud Manager

Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs

® intemet

adm v %

B status | Link Health
& intemet Status Uplink Carrier Usage Throughput Latency Loss Signal Strength(dBm)
@ Local Network - 4 50.10MB 39674 Kb/s .
. want = v 35488 MB 8028 Kb/s 278 ms 0%
= wiF
13164 MB -
G s Cellular(siM1) Vassie g 0000ms odem
Securit
o % WANT v
W Services Throughput
@ system 286 Mb/s
228 M/
191 Mb/s
1.43 Mb/s
97656 Ke/s
sg828
000K/s e o L A
133000 134500 140000 1415:00 143000 144500 150000 151500
Latency
500000 ms
400,000 ms |
300000 ms ‘ ‘ I
R | | Ll L L | o A PORRLl 15, Y
134500 140000 14:15:00 1430:00 144500 150000 151500

Figure 6-1 Link Monitor

6.2 Cellular Signals

The [ Cellular Signals ] module displays the SIM card signal strength on the cellular interface, as well as

other parameters such as the received signal strength indication (RSSI), signal to interference plus noise ratio
(SINR), and reference signal receiving power (RSRP).

3%, ERBOS

& InGoudMansger  © Imtemet e
® Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
B sus |
Signal Strength e
& Interet.
o oo » I
= wiri
VPN
© secuity 210000 20000 00000
® Services
RSS! s
o system
= i
@
[ | 1 L m T 1
o
%
o
o
ss-Rsk Wi
=
«
r | Ry g
w| 4 | - u
2
-
o0 o

Figure 6-2 Signal strength

15
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6.3 Clients

The [ Clients ] module displays details about each client connected to the router, such as its name, IP
address, MAC address, VLAN ID, connected subnet, traffic statistics, and online duration.

hf;};n ERB05 & InCloud Manager ~ ® Internet adm v %
@ Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
W St | Ao | Wired 0 | Wireless 0 || Name v/
& internet
Name 1P Address MAC Address VIAN Connection Traffic up Down Uptime.

@ Local Network
= wiF
¢ veN
No Data
@ security

® Services

o Spsem

Figure 6-3 Clients

6.4 VPN

The [ VPN'] module displays information about IPSec VPN and L2TP VPN, such as their status, name,
traffic statistics, and duration of the latest connection.

¥, ERB05 & InCloud Manager @ Intemet adm + %
@ Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
Bsis | IPSec || L2TP

& Intemet
Status  Name Uplink Interface Interface Address Remote Address Available Subnets Traffic Last Connection Time

@ Local Network
sos-- want 10547.58 10547.022 : 08
= WiFi
% ven
© securty

® services

& sstem

Figure 6-4 VPN

6.5 Events

The [ Events ] module displays the events that have occurred during operation of the router, helping you
understand its running status.

<
\;ﬁ", ER605 & InCloud Manager ~ ® Intemet e
@ Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
B Statls | - Enddate B % ClearEvents | | ExportEvents C
& Internet
Time Type Content
® Local Network
2022-12-26 15:23:28 Login successfully Cloud remote access login successfully
= wisi
2022-12-26 15:16:01 Login successfully Cloud remote access login successfully
% veN
2022-12-26 15:14:50 Configuration changed Router configuration updated
© searty
0 e 2022-12-26 15:14:47 Login successfully Cloud remote access login successfully
O System 2022-12-26 151357 Login successfully Cloud remote access login successfully
2022-12-26 1220022 Login successfully Cloud remote access login successfully
2022-12-26 11:2037 Login successfully Cloud remote access login successfully
2022-12-26 10:47:34 Uplink status changed Cellular(s1M1) is disconnected
2022-12-26 10:21:05 Login successfully Cloud remote access login successfully
2022-12-26 07:48:16 Link detection status changed The Cellular(SinT) link detaction is successful

Figure 6-5 Events

16



[0 -

inhand InHand ER605 User Manual @

The router supports the following types of events:
*  Login successfully/failed

¢ Configuration changed

e CPU utilization is too high

*  Memory utilization is too high

* VPN status changed

¢ Uplink status changed

¢ Uplink switched

*  WAN2/LANI switched

*  Detection status changed

*  Cellular traffic reaches the threshold
*  Reboot

*  Upgrade

6.6 Logs

The [ logs ] module displays logs recorded during operation of the router, which can be used for
troubleshooting when the router does not work properly. You can download and delete logs.

3%, ER6O5S 4 InCloud Manager ~ ® Intemet adm v %
@ Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
B stats | Level: | ALL V| key: Search | | Reset s0lines \ || ManualRefresh\v | C
& Internet
Level Time Content
@ Local Network
= Win Information Dec 26 15:31:09 charon: 14[CFG] rereading crls from '/etc/ipsec.d/crls'
Information Dec 26 15:31:10 ipsecwatcher2[970]: ipsec update, edit tunnel 605--
£ P 1970]: ipsec update, o
Information Dec 26 15:31:10 charon: 07[CFG] received stroke: terminate '605--'
9 seariy
Information Dec 26 15:31:10 charon: 09[IKE] destroying IKE_SA in state CONNECTING without notification
© senvices
Information Dec 26 15:31:11 ipsecwatcher2{S70]: ipsec delete config file for tunnel (605--]
© System
Information Dec 26 15:31:11 charon: 0S[CFG] received stroke: delete connection ‘605
Information Dec 26 15:31:11 charon: OSICFG] deleted connection 605
Information Dec 26 15:31:11 ipsecwatcher2(870} ipse create config file for [605-1] begin
information Dec 26 15:31:11 ipsecwatcher2(570}: ipsec create config file for [605-] OK
Information Dec 26 15:31:11 charon: 11[CFG] received stroke: add connection '605--
Information Dec 26 15:31:11 charon: 11[CFG] added configuration ‘605
Information Dec 26 15:31:11 charon: 0SICFG] received stroke: initiate ‘605
Information Dec 26 15:31:11 charon: 09[IKE] initiating Main Mode IKE_SA 605--[1679] to 10.5.47.122
Information Dec 26 15:31:15 charon: O7[IKE] sending retransmit 1 of request message D 0, seq 1
Information Dec 26 15:31:22 charon: 16[IKE] sending retransmit 2 of request message D 0, s2q 1
Information Dec 26 15:31:35 charon: 11[IKE] sending retransmit 3 of request message ID 0, seq 1

Figure 6-6 Logs
*  Clear Logs: clear running logs of the router.
e Download Logs:download running logs of the router.

*  Download Diagnostic Logs: download log information for troubleshooting, it contains system running
logs, device information, and device configuration.
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7 Internet

On the [ Internet ] page, you can set parameters for the uplink interfaces and specify a multi-link work
mode.

Notes:

e  Exercise caution when changing settings on the [ Internet ] page, as doing so may cause an
interruption of the network connection.

7.1 Uplink Table

On the uplink table, you can edit WANI and Cellular, and add, edit, or delete WAN2 and Wi-Fi(STA). For

details, see section 4.2 Internet Connection. You can drag icons in the Priority column to reprioritize the
interfaces.

e
5. ERBOS & InCloudManager ~ ® Intemet S
@ Dashboard Uplink Table
B status 4+ Add
£ interriet | Priority Name Status Interface Type: Type Actions
@ Local Network P
= WAN1 Enable WAN DHCP 2 Edit
= WiFi
1= Cellular Enable Cellular: SiM1 Dialup 2 &dit | £ Policy
¢ veN
o Note: Modifying the configuration of the intermet interface or adjusting the priority may cause the device network to be interrupted!
ecurity
@ senices
Uplink Setting
© system

Link Detection: o©

Test Connectivity to;

Enabled Last Time Detection item Constraint Value
5 min Latency is less than 200ms
5 min Jitter is less than 200ms
5 min Loss is less than 5%
5 min signal strength is greater than Poor

(@) Link Backup
Failover Mode: Immediately Switch

Load balaneing

Figure 7-1 Uplink list
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7.2 Uplink Settings

On the [ Internet] page, you can configure link detection and set parameters for the uplink interfaces.
Uplink Setting

Link Detection: O

Test Connectivity to:

Enabled Last Time Detection Item Constraint Value
5 min Latency is less than 200 ms
5 min litter is less than 200 ms
5 min Loss is less than 5%
5 min Signal Strength is greater than Paor

{®) Link Backup
Failover Mode: mmediately Switch
Load balancing

Figure 7-2 Uplink settings

* By default, link detection is enabled. In the private network environment, please manually configure the
address that can be detected or disable the link detection function to prevent the cellular interface from
working normally. When this function is disabled, the Status page does not display the transmission
latency, jitter, packet loss rate, or signal strength on each uplink interface.

e If the link detection address is left empty, the system detects the primary dns server address obtained by
each interface. When the IP address of the link detection is filled in, all uplink use this address as the
detection address

*  When the router works in link backup mode, you can enable the items to be detected. The router then
monitors these items and triggers a link switch when any item exceeds the threshold. If no item is
enabled, link switch is only triggered based on priority and connectivity of the links.

*  When the router works in load balancing mode, all the links forward traffic on a per packet basis.
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8 Local Network

On the [ Local Network ] page, you can add local subnets and assign them to clients connected to the router
through the LAN interfaces or SSIDs.

8.1 Passthrough Settings

Through this function, the router's uplink interface address can be transparently transmitted to the client
device for use.

Name. 1P Address/Mask VLAN Actions

Default 192.168.66.10/24 1 2 Edit

Figure 8-1 Passthrough Settings

Note:

e After the IP Passthrough mode is enabled, only one client can access the Internet. The following
functions will not work:

Static routing. VPN, Port Forwarding, Policy-Based Routing, SD-WAN Overlay, Connecor.

e  You can still access the router via the IP address of the default subnet.

8.2 Local Network List

Click Add or Edit to add a local network or edit an existing local network.

Figure 8-2 Adding a local network
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Notes:

*  The default local network cannot be removed. You can only change its IP address/mask, and DHCP
server configuration.

*  After a local network is added, its mode cannot be changed.

*  The VLAN Only mode is used for transparent transmission of Layer 2 protocol packets. Therefore, you
do not need to set the IP address/mask and DHCP Server for this mode.
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The ER605 can serve as an AP to provide multiple SSIDs for wireless network access. You can define SSIDs
for different purposes and set parameters for these SSIDs.

£, ER605

@& Dashboard Vi e
M st ot ade

ssiD status Network Band(Channel) Security Encryption Actions
ERG05-000206 Enable Default 24GHz (Auto) WPA2-PSK. <" 2 Edit

ER605-5G-000207 Enable Default 5GHz (36) WPA2-PSK ccMP 2 Edit

Figure 9-1 Wi-Fi list

Click Add or Edit to add an SSID or edit an existing SSID.

Add Wi-Fi

*gsiD: \: Please enter

status: @

*Band: @ 24GHz () 5GHz
* password: | please enter ® |
* Channel: Auto

User isolation: ||

Cancel ‘

Figure 9-2 Editing an SSID

*  The router has two default primary SSIDs, one for the 2.4 GHz band and one for the 5 GHz band. You
cannot change the bands of the two SSIDs or delete the SSIDs.

e After an SSID is added, its band cannot be changed, and its channels are automatically synchronized
with channels of the corresponding primary SSID.

e Ifyou have added the Wi-Fi(STA) interface on the [ Internet] page, none of SSIDs on the same band
as the Wi-Fi (STA) interface can be enabled, until this interface is removed.
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10 VPN

A virtual private network (VPN) is a private network established on a public network for encrypted
communication. A VPN gateway encrypts data packets and translates destination IP addresses of data
packets to implement remote access. The VPN service can be provided through a server, hardware client, or
software client.

10.1 IPSec VPN

IPSec VPN is an open network security protocol suite developed by IETF to ensure secure data transmission
over the Internet through source authentication, data encryption, data integrity check, and anti-replay at the
IP layer. This protocol suite lowers the risks of data leakage and interception, and ensures the data integrity
and privacy, thus protecting the security of communication.

Choose VPN > IPSec VPN, and click Add to add an [ IPSec VPN. ]

;;}:‘, ER605 & InCloud Manager @ Internet adm v %

® Dashboard IPSecVPN  L2TP VPN

B status +add
& internet Name. IKE Version Uplink Interface Peer Address Local Subnet Peer Subnet Actions

® Local Network
605~ IKEVI WANT 105.47.122 192.168.66.0/24 192.166.2.0/24 2 gdit | O Delete
= Wi
¥ VPN
@ Ssecurity

@ Services

O System

Figure 10-1-1 Adding an IPSec VPN

3%, ERBOS & inCloudManager @ Intemet
A= cond € Add IPSec VPN
B Status
* Name:
& Internet
IKE Version: IKEVT
@ Local Network
# Pra-Shared Key:
T W
Uplink Interface WANT
* N
*# Peer Address:
D Security
Tunnel Mod T
® Senices
Local Subnet
£ System
+ Acd
Peer Subnet
+ Add
IKE Policy
Encryption: AES128
Authentication: SHAT
DH Groups
“ Lifetime (seconds) 86400
1PSec Policy

Security Protocol: £sP

Ence

Authentication SHAT
PFS Groups:

* Lifetime (seconds): 86400

Figure 10-1-2 Setting the new IPSec VPN

After the IPSec VPN configuration is completed on both sides, an IPSec VPN tunnel is established. To check the status
of this tunnel, click Status on the left pane, and then click the VPN tab. The following parameters must be set:

*  Name: specifies the name of the [IPSec VPN created on the router, which is used for local VPN management.
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IKE Version: specifies the version of the Internet Key Exchange (IKE) protocol used on the router, which can be
IKEv1 or IKEv2.

Pre-Shared Key: specifies the authentication key for IKE negotiation, which must be consistent on both sides.
Internet Interface: specifies the local uplink interface used to establish the IPSec VPN tunnel.

Tunnel Mode: specifies the IP packet encapsulation mode on the IPSec VPN tunnel, which can be tunnel mode or
transfer mode.

Peer Address: specifies the [P address of the peer device that will establish a tunnel with the ER605.
Notes:

When two ER series routers establish an IPSec VPN tunnel, the one using a public IP address acts as the
server by default. On the IPSec server, the peer IP address must be set to 0.0.0.0. On the IPSec client, the peer IP
address must be set to the public IP address of the server's interface used to establish the tunnel.

Local Subnet: specifies the IP address segment of the traffic to be sent out by the ER605 through the
IPSec VPN tunnel.

Peer Subnet: specifies the IP address segment used for communication on the other end of the IPSec
VPN tunnel.

IKE Policy: allows you to set IKE parameters.

B Encryption: specifies the encryption algorithm for IKE.

B Authentication: specifies the authentication algorithm for IKE.
B DH Groups: specifies the DH key exchange mode.
|

Lifetime: specifies the lifetime of the IKE security association (SA). The default value is 86400
seconds.

IPSec Policy: allows you to set IPSec parameters.
B Security Protocol: specifies the security protocol used for the External Router Protocol (ERP).

B Encryption: specifies the encryption algorithm for the Encapsulating Security Payload (ESP)
protocol.

B Authentication: specifies the authentication algorithm for ESP.

B PFS Groups: specifies the Perfect Forward Secrecy (PFS) mode, which improves the
communication security through an additional key exchange in Phase 2 of negotiation.

B Lifetime: specifies the lifetime of the [PSec SA. The default value is 86400 seconds.

10.2 L2TP VPN

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol for virtual private dial networks (VPDNs). This
protocol establishes a tunnel from a remote site to the headquarters of an enterprise over a public switched
telephone network (PSTN) or integrated services digital network (ISDN) through Point-to-Point Protocol
(PPP) negotiation. This tunnel allows remote users to connect to the intranet of the enterprise in a secure

way.

10.2.1 Client

The ER605 can serve as an L2TP client to establish a tunnel to a remote L2TP server. Choose L2TP VPN >
Client onthe [ VPN] page, and click Add to add an L2TP client.

24



inhand InHand ER605 User Manual @

& InCloud Manager ~ ® Intemet

@ Dashboard IPSec VPN L2TR VPN

Server | Client

& Internet
® o Name Status Uplink Interface Server Address. Authentication Mode Tunnel Verification Actions
= wi
o e |
® Secuy
@ Services
& Syptem
[~
uipn‘}n'u ERB05 & InCloud Manager ® Intemnet
@ Dashboard
< Add L2TP Client
B Status
& |Internet # Mame:
# Local Network Status: [ 9)
= Wi NAT:
%' VPN Uplink Interface: A ny v
O Security # Server Address:
@ Services # User Name:
& System * Password: @

Authentication Mode: AUTO v

Enable Tunnel Verification:

Save Cancel

Figure 10-2-1-a/b Adding an L2TP client
¢ Name: specifies the local identifier of the L2TP client.
e Status: enables or disables L2TP tunneling on the client.

¢ NAT: enables or disables network address translation (NAT) for packets forwarded by the router for the clients
connected to it.

¢ Uplink Interface: specifies the uplink interface used to establish a tunnel from the L2TP client to the server.
¢ Server Address: specifies the IP address used by the remote L2TP server to communicate with the L2TP client.

¢ User Name/Password: specifies the user name and password for L2TP negotiation, which must be consistent on
both ends of the tunnel.

*  Authentication: specifies the authentication mode for the L2TP tunnel.

¢ Enable Tunnel Authentication: When this option is selected, make sure both ends of the tunnel are configured
with the same server name and verification key.

10.2.2 Server

Generally, an L2TP server is deployed at the headquarters of an enterprise to provide remote access for
employees on the move or in branches. On the VPN page, choose L2ZTP VPN > Server to display the L2TP
server configuration page.
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=
;ﬁ,\.n"u ERB05 & InCloud Manager @ Intemet
® Dashboard IPSec VPN L2TP VPN
B Status Server Client
& Internet
Name: L2TP Server
# Local Network
Status: (@ ]
= Wi-Fi
Uplink Interface Any
% VPN
* VPN Connection Address:
Security
IP Paal: =
@ Services
* User Name:
O System

* Password :
Authentication Mode! AUTO v

Enable Tunnel Verification:

Save Reset

Figure 10-2-2 L2TP server configuration
¢ Name: displays the name of the L2TP server, which cannot be changed.
e Status: enables or disables the L2TP server function. This function is disabled by default.
¢ Uplink Interface: specifies the uplink interface used to establish a tunnel from the L2TP server.

* VPN Address: specifies the gateway address for the L2TP client. The gateway assigns an IP address to the L2TP
client from the specified IP address pool.

*  Address Pool: specifies the IP address range for the L2TP client.

¢ User Name/Password: specifies the user name and password for L2TP negotiation, which must be consistent on
both ends of the tunnel.

*  Authentication: specifies the authentication mode for the L2TP tunnel.

*  Enable Tunnel Authentication: when this option is selected, make sure both ends of the tunnel are configured
with the same user name and password.
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11 Security

On the Security page, you can configure advanced security features, including firewall, policy-based routing,
and traffic shaping.

11.1 Firewall

You can set inbound and outbound rules and port forwarding for the firewall.

11.1.1 Inbound and Outbound Rules

You can set inbound and outbound rules to control inbound and outbound traffic on an interface. For
example, if a large number of attacks are initiated from an IP address, you can set an inbound rule on the
firewall to restrict traffic sent from this IP address.

If you want to prevent some internal users from accessing the Internet, set an outbound rule to restrict
outbound traffic sent from these users. Inbound and outbound rules contain the same parameters and differ
only in default settings. The following figure shows an example of adding an inbound rule.

s ERB0S & InCloud Manager @ Intemet

@ Dashooard Firewall  Policy-Based Routing  Traffic Shaping

8 s Outbound Rules | Port Forwarding
& internet =
AL Priority e Statis e Protocol G Destination T Ao
= Wi - 0 £
N
© s
® Senices
© Sptem
Add Inbound Rules X
* Mame:
status: @D

Interface: | Any
Protocol: | Any
Source: | Any
Destination: | Any

Behavior: (@) Permit Deny

Figure 11-1-1-a/b Adding an inbound rule
* Name: specifies the local identifier of the inbound rule.
e Status: enables or disables the rule.

* Interface: specifies the traffic forwarding interface. For an outbound rule, select the interface from
which traffic is sent out. For an inbound rule, select the interface on which traffic is received.
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Protocol: specifies the protocol type of packets to be matched. Options are Any, TCP, UDP, ICMP,
and Custom.

*  Source: specifies the source IP address of packets to be matched. You can enter an IP address or retain
the default option Any.

* Destination: specifies the destination IP address of packets to be matched. You can enter an IP address
or retain the default option Any.

*  Behavior: specifies the action taken for packets matching the rule. Options are Permit and Deny.
*  Inbound rule: controls external traffic received by the router. By default, all external traffic is denied.
*  Qutbound rule: controls traffic sent out through the router. By default, all outbound traffic is permitted.

You can reprioritize inbound and outbound rules on the rule list.

11.1.2 Port Forwarding

After a port forwarding rule is configured on an interface of the router, the router forwards data traffic
arriving at this interface to the specified port on the target internal client. In this way, services deployed on
the intranet are available for external users. The port forwarding feature allows the router to forward packets
of different ports to different private IP addresses and ports, so that the same public IP address can be used to
access multiple servers. For example, if external users need to access the service with port 1024 on the client
with the IP address 192.168.2.10, you can map this port to port 1024 on WANI. Then, external users can
access data of this service on the client by entering https://IP address of WAN1:1024 in the address box of
their web browser.

8. ER6OS

® Dsshboard Firewall  Policy-Based Routing Traffic Shaping

Inbound Rules || Qutbound Rules | Port Forwarding

Name Status Interface. Public Port Protocol Local Address Local Port Actions.

Add Port Forwarding X

* Mame:

status: @D

Interface: | Any
Protacol: | TCP&UDP
* Public Part:
¥ Local Address:

* Local Port:
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Figure 11-1-2-a/b Adding a port forwarding rule
¢ Name: specifies the local identifier of the port forwarding rule.
e Status: enables or disables the port forwarding rule.

¢ Interface: specifies the uplink interface that provides port mapping for internal clients. This interface must have a
public IP address.

*  Protocol: specifies the protocol type to which port mapping is applied. Options are TCP, UDP, and TCP&UDP.

¢ Public Port: specifies the protocol port on the uplink interface to be mapped to the protocol port on the internal
client. The value range is the same as that of Local Port.

*  Local Address: specifies the IP address of the target client that external users need to access.

*  Local Port: specifies the protocol port that external users need to access on the target client. The value range is the
same as that of Public Port.

11.2  Policy-based Routing

Policy-based routing (PBR) allows the router to forward different data flows through different links based on
the configured policies. This feature enables flexible route selection and control, thus improving the link
utilization and reducing operational cost of the enterprise. Choose Security > Policy-based Routing and
click Add to add a PBR rule.

3%, ERE05 & InCloud Manager  ® Intemet

@ Dashboard Firewall  Policy-Based Routing  Traffic Shaping

B stts
B e Priority Name. Status Protacol Source Destination Export Actions
@ Local N k.
% VPN
Q@ Sew
@ Services
Add Policy-Based Routing X
* Mame:
status: @D
Protocol: | Any W
Source: | Any W
Destination: | Custom v
Output: | WAN1 W
Figure 11-2-a/b Adding a PBR entry
Notes:

®  The source and destination addresses of the PBR entry cannot be set to Any at the same time.
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11.3 Traffic Shaping

To optimize your network, you can create shaping policies to apply per-user controls on a per-protocol basis.This
allows you to reduce bandwidth for recreational traffic, and to prioritize bandwidth for your business-critical enterprise
traffics.Choose Security > Traffic Shaping and click Edit to modify the bandwidth of the uplink.

3%, ER605 & InCloud Manager ~ ® Intemet

@ Deshooard Firewall  Policy-Based Routing  Traffic Shaping

Uplink Bandwidth

Uplink Interface Up Bandwidith Down Bandwidth Actions

WANT Unilimited Unlimited £ Edit
= Wi
Cellular * Unlimited Unlimited 2 Edit
% ven
© Secury
Shaping Rules
® Senvices
+ Add
& System
Queue Name Status Protocol Source Destination Priority DSCP Tags Limit Bandwicith Reserved Bandwidth Actions

Figure 11-3-a Editing uplink bandwidth

Click Add Create a new rule to add a traffic shaping rule. Traffic shaping policies consist of a series of rules that are
performed in the order in which they appear in the policy, similar to custom firewall rules. There are two main
components to each rule: the type of traffic to be limited or shaped (rule definition), and how that traffic should be
limited or shaped (rule actions).

J;};EHSOS & InCloud Manager ~ ® Internet

@ §Peshizcard & Add Traffic Shaping Rules

B status

& internet # Name:

@ Local Network Status: ()
= Wi-Fi Protocol Any
% weN Source: Any
O security Destinati Any
@ Services Priority Highest v
€@ system DSCP Tags: Do not change DSCP tag v
Limit Bandwidth up: O [ Mbps v
D o Mbps
Reserved Bandwidth Up: O 0 Mbps
Down: 0 Vibps
Save Cancel
Figure 11-3-b Adding traffic shaping rule
Note:

e  Traffic forwarding priority for unmatched rules is medium.
e  When the bandwidth is set to 0, the rate of traffic is not limited.

e  The value of guaranteed bandwidth should not be greater than the limit bandwidth.
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12 Services

12.1 Interface Management

Inthe [ Interface Management ] module, you can specify the local subnets allowed to communicate with
external networks, and set a rate limit for the interface.

32, ER605 & inCloud Manager ~ ® Intemet 2=

@ Dashbozrd

Interface Management
B Status

Interface Status Network Link Rate Actions
& Internet

Lt Ensble a o
® Local Network

Lanz Enable Al Auto 2 Edt
= Wi

Lanz Enable Al Asto 2 Edt
= ven

Lang Ensble il At 2 Edit
@ secury
© Services DHCP Server ”
& System

Fixed Address List >

Static Routes

Edit LAN1 Interface X

Interface: LAM1

status: @D
* Network: | All

* Link Rate: | Auto

Cancel Save

Figure 12-1-a/b Editing a LAN interface

12.2 DHCP Server

DHCP implements dynamic IP address allocation in a client/server model. The client sends a configuration
request to the server, and the server replies with an IP address assigned to the client.

2% ERBOS & Incloud Manager  ©  Intemet m
@ Dashooars

Interface Management >
B seus
S rione DHCP Server v
Stk Network Status DHCP IP Range Lease oNs Actions
i Default Enable 192.168.66.1 - 192.166.66.254 1 day Auto 2 Edit
VN
Securiy Fixed Address List 3
® Senices

Static Routes >
o syptem
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Edit DHCP Server X

Network: Default
10,5.22.1/24

status: @D
* DHCPIP Range: | 10.5.22.1 - | 10.5.22.254
# Lease: | 1day W
¥ DN5: | Auto v

Figure 12-2-a/b Editing a DHCP server

e DHCP servers are created on the router based on local networks connected to the router. When a local
network is removed, the DHCP server for this network is also removed.

e The DHCP server function is available only for local networks in IP mode. It does not take effect for
networks in VLAN Only mode.

12.3 Fixed Address List

You can assign fixed IP addresses to clients connected to the router based on their MAC addresses.

2%, ER605

& InCloud Manager  © Intemet

@ Dashboard
B St

& Intemet

® Local Network
= WA

w e

© Securty

O System

MAC Address 1P Address Clients Actions

Tof Trecords < [1]5

Static Routes

5

Figure 12-3 Adding a fixed IP-MAC address mapping

e The IP address assigned must be in the IP address range of the local network in IP mode.

*  When a local network is removed, all the address mapping entries in the IP address range of the network
are deleted.
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12.4 Static Routes

You can configure static routes to direct data traffic to specified routes and interfaces. The static route list
displays only manually created routes and does not include the routes generated automatically on uplink
interfaces.

Add Static Routes

R

Type: | NextHop v

Nt Hop: |

oy a0

Description

Figure 12-4 Adding a static route

e Static routes to the same destination IP address or network cannot have the same next-hop address,
outbound interface, or preference.

*  When WAN2, Wi-Fi(STA), or the interface serving as an L2TP VPN client is removed, static routes
using this interface as the outbound interface are also deleted.
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13 System

On the System page, you can configure various functions, including cloud management, remote access
control, clock, device options, configuration management, alarms, tools, and log server.

13.1 Adm Management

The initial user name for the router is adm and the initial password is 123456. Change the password to
enhance security. Click adm in the upper right corner of the page, and select Change Password.

%, ER60S & InCloud Manager ~ © Intemet

ame: ERE05 £ odel: ERG5-NRQ2-WLAN Seria Firmware Version: V203

IAC: 00:1805:0002:04 ptime: 1w cess: WANI Uplink IP: 10547.158

3y IP: 1921686610 System Time: 2022-12-26 154408 UTC +0800

& VN Interface Status

m,,
® seis -

Cellular WANT  LAN1 LAN2 LAN3 LAN

Traffic Statistics

Cellular(SIM1)

Wi-Fi Connections Clients Traffic Top5

Modify Password X

Username: adm
¥ Mew Password !

* Confirm Password

Cancel Save

Figure 13-1-a/b Changing the password of adm

13.2 Cloud Management

InCloud Manager (star.inhandcloud.com) is a cloud platform developed by InHand to help enterprises
accelerate network deployment, simplify network O&M, and improve service experience. This platform
provides zero touch deployment, intelligent O&M, and security features to create good service experience
for users. When your devices are connected to the cloud platform, you can log in to the platform to manage
the devices remotely, perform batch configuration, and monitor traffic on these devices.
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In the [ Cloud Management ] module, you can select the cloud platform you want to visit. When the cloud
platform and cloud management service are no longer needed, you can disable the cloud service

3%, ER605 & inCloud Manager ~ ® Intemet

@ System | Remote Access Control s
System Clock >
Device Options >
Configuration Management >
Device Alarms >
Tools >
Log Server >

Other Settings >

Figure 13-2 Cloud management
Notes:

e The ER605 connects to the InCloud Manager platform automatically. If you do not want to use this
platform, disable the cloud service manually.

13.3 Remote Access Control

In the [ Remote Access Control ] module, you can determine whether to allow access to the web-based
management system of the router from the Internet, and specify the allowed protocol ports.

3%, ERB05 & inCloud Manager ~ ® Intemet

Cloud Management >

& Intermet Remote Access Control v
® Lol Network

- HTTPS @ oores |43

% VN = & -

@ security e o™

& Senices &

System Clock >

Configuration Management >
Device Alarms >
Tools >
Log Server >

Other Settings >

Figure 13-3 Configuring remote access control

¢ HTTPS: when this service is enabled, you can access the web-based management system of the router remotely by
entering the public IP address and port of its uplink interface in the address box of the web browser.

. SSH: when this service is enabled, you can use a remote access tool, such as CRT, to log in to the web-based
management system of the router by entering the public IP address and port of its uplink interface, as well as the
user name and password.
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*  Ping: when this service is enabled, ping requests can be initiated to the IP address of the uplink interface from
external networks.

Notes:
*  Remote access control does not apply to LAN interfaces.

e  Firewall policies do not restrict remote access.

13.4 System Clock

In the [ System Clock ] module, you can select a time zone for the system and enable the NTP server to
synchronize time with the target NTP server.

System Clock

Time Zone: UTC +08&00 China,Hong Kong,T...

NTP Server: @D
* NTP Serverl: | poolntp.org * Port: | 123

NTP Server2: Port:

m ReE Et

Figure 13-4 Setting the system clock

13.5 Device Options

In them [ Device Options ] module, you can reboot the router, upgrade the firmware, and restore factory
settings of the router.

Device Options

Reboot the router Reboot
Upgrade the router firmware version Upgrade
Restore the router to factory settings RGNS = Ta sl

Figure 13-5 Device options

Notes:
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*  Before upgrading the firmware, make sure the new firmware is obtained from an official source. If a
wrong firmware is loaded, the router will be unable to work.

*  When the router is connected to the cloud platform, the cloud platform synchronizes the settings
configured before you restore the factory settings to the router again. The router only clears historical
data.

13.6 Configuration Management

You can export the configuration file of the router to your PC as a backup. Once the configuration is lost on
the router, you can import the configuration file to the router to restore the configuration.

Configuration Management v

Local Backup

Figure 13-6 Configuration management

13.7 Alarms

If you need to monitor some events that may occur on the router, select the matching alarm events in the
Alarm Settings module and specify an email address for receiving alarms. When an event of the specified
type occurs, the router sends an email to the specified address. The unselected alarm events are recorded in
logs on the router.

The router supports the following events:

< Device Alarms

Alarm Settings v [ selectall
(Mail Receiving)

Cellular traffic reaches the threshold
VPN status changes

Uplink status change

Failover occurs

WANZ2/LANT switch

Reboot

Uparade

Figure 13-7-a Alarm settings

After you set the mail server address, port, user name, and password, the router uses the specified mailbox to
send alarm emails. You can send a test email to check whether the mail server configuration is correct.
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Receive Mail Settings

Enable: (e ]

* Mail Server Address: inhand mail.com.cn

* Mail Server Port: 25

* Username: ts@inhand.com.cn

*#Password: | esaee B
TLS:

* Receiving Email Address:

+ Add
Send a test email to:

Save Reset

Figure 13-7-b Mail server settings

13.8 Tools
13.8.1 Ping

The ping service is used to test the connectivity between the router and external networks through the
Internet Control Message Protocol (ICMP). Enter any domain name or IP address in the Target field, and
then click Start to test the connectivity with this target.

Ping

* Target 2238
Interface Any

* Packet Size: &4

* Packet numbers: 4

B o

PING 8.8.8.8 (3.8.8.8): 64 data bytes

72 bytes from 6:8.8.8: seq=0 tt=350 time=91.376 ms
72 bytes from 8.8.8.8: seq=1 tt=50 time=89.177 ms
72 bytes from 8:8.8.8: seq=2 tI=50 ime=90.676 ms
72 bytes from 8.8.8.8: seq=3 tt=50 time=00.155 ms

--- 8.8.8.8 ping statistics -
4 packets transmitted, 4 packets received, 0 Ox1acket loss
round-trip min/avg/max = 89.177/90.346/91.376 ms

Figure 13-8-1 Ping

13.8.2 Traceroute

Enter the IP address of the target host, select an interface, and then click Start to test the route to the
destination IP address.

Traceroute
* Target: 8883
Interface Any

traceroute to 88,88 (8:8.8.8), 30 hops max, 38 byte packets
e

S

4 1119130241 (111.9.130.241) 28.993 ms 34.698 ms 34.048 ms
5 22387.2645 (22387.26.45) 24967 ms 37.221 ms 35846 ms

Figure 13-8-2 Traceroute
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13.8.3 Packet Capture

You can capture data packets on a specified interface. By selecting an option from the Qutput drop-down
list, you can view information about the captured data packets or export the information to your PC.

Capture
Interface: Any Sample filter expressions

e.g.Packets to and from ip address 1.1.1.1: host 1.1.1.1
e.g.Packets to and from ip address 1.1.1.1 and TCP or UDP port 53
host 1.1.1.1 and port 53

Filter Expression:

* Time: 60

e.g, All ICMP packets that are not eche reguests/replies:
icmplicmptype] = icmp-echo and icmplicmptype] != icmp-echoreply
e.g.Ether host 11:22:33:44:55:66:

m ether host 11:22:33:44:55:66

For more information, please refer to:  http://www.tepdump.orgy

Output! Wiew output below v

Figure 13-8-3 Packet Capture
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FCC STATEMENT

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that may cause
undesired operation.

NOTE 1: This equipment has been tested and found to comply with the limits for a Class B
digital device , pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

-Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

-Consult the dealer or an experienced radio/TV technician for help.

NOTE 2: Any changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

RF Exposure

The equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. This device should be installed and operated with minimum distance 20cm
between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or
transmitter. The availability of some specific channels and/or operational frequency bands is
country dependent and firmware programmed at the factory to match the intended destination.
The firmware setting is not accessible by the end user.

The EUT only works at 5150~5250MHz frequencyand 5725~5850MHz frequency.
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IC STATEMENT

This device complies with Industry Canada license-exempt RSS standard(s): Operation is
subject to the following Two conditions:

(1) this device may not cause interference, and

(2) This device must accept any interference, including interference that may cause
undesired operation

of the device.

Le present appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) I'appareil ne doit pas produire de brouillage, et

(2) l'utilisateur de 'appareildoit accepter tout brouillage radioélectrique subi, méme si le
brouillage est

susceptible d'en compromettre le fonctionnement.

CAN ICES-3 (B)

Avis d’Industrie Canada

Le présent appareil est conforme aux CNR d'industrie Canada applicables aux appareils radio
exem pts de licence L'exploitation est autorisée aux deux conditions suivantes:

1) I'appareil ne doit pas produire de brouillage; et

2) I'utillsateur de I'appareil doit accepterbrouillage radioélectrique subi meme si le brouillage
est susceptible d'encompromettre le fonctionnement. mauvais fonctionnement de ['appareil.
Cet appareil numériquie de la classe B est conforme & la norme NMB-003 du Canada.

CAN NMB-3 (B)

Radiation Exposure Statement:

This equipment complies with IC radiation exposure limits set forth for an uncontrolled
environment. This equipment should be installed and operated with minimum distance 20cm
between the radiator & your body.

Déclaration d'exposition aux radiations:

Cet équipement est conforme aux limites d'exposition aux rayonnements IC établies pour un
environnement non controlé. Cet équipement doit étre installé et utilisé avec un minimum

de 20cm de distance entre la source de rayonnement et votre corps.

Frequency band 5150-5250 MHz in Canada for indoor use only.
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